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Chapter  1  IChapter 1 Introduction  ntroduction

1.1 Overview 
This document provides the specifications, functions, and operating instructions of software for Microsoft 
Windows provided by Seiko Instruments Inc. (hereinafter referred to as “SII”) for SII thermal printers. 

1.2 Operating Description 
Operating instructions and screenshots described in this document are explained assuming that the operating 
system uses standard settings during the installation. The operating instructions and screenshots may be 
different if the operating system settings have been changed. 

1.3 Operating System Abbreviations 

Operating systems described in this document use the following abbreviations: 

• Microsoft Windows  =>  Windows 
• Microsoft Windows Vista  =>  Windows Vista 
• Microsoft Windows XP  =>  Windows XP 

1.4 Printer Folder Representation 
[The printer folder] described in this document means the folder displayed for the following operations: 

For Windows Vista 

[Start] => [Control Panel] => [Hardware and Sound] => [Printer] => [Printers] folder 

For Windows XP 

[Start] => [Control Panel] => [Printers and Faxes] => [Printers and Faxes] folder 
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1.5 Other Representations 

The terms below used in this document have the following meanings: 

• Printer  Technical  Reference  => [Each target devices of INTERFACE BOARD TECHNICAL 
REFERENCE or CHIP SET TECHNICAL REFERENCE] 

Printer Technical Reference

• Auto  Status  Response       =>A status data retrieved by executing a command of SII thermal printer 
[Automatic Status Response]. 

Auto Status Response

1.6 System Requirements 
System requirements for the printer driver are as follows: 

Item Specifications 

Supported Host Computer PC-AT Compatible Machines  
(DOS/V Machines) 

Supported Operating Systems

■ Windows XP Home Edition 
■ Windows XP Professional Edition 
■ Windows Vista Home Basic 
■ Windows Vista Home Premium 
■ Windows Vista Business 
■ Windows Vista Ultimate 

Communication Methods 
■ USB Communications 
■ Serial Communications (RS-232C) 
■ Parallel Communications 

 

For settings of printer side, refer to the “Appendix D Condition of Function Settings”. 
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Chapter  2  IChapter 2 Installation  nstallation

2.1 Overview 
The following describes the procedure to install the printer driver. 
To install the printer driver, log on to the computer with administrator privileges. 

2.2 Driver Model 

For appropriate printer driver types, refer to the “Appendix A Driver Model”. 

2.3 Installation Methods 
The following describes the procedure for installation of the printer driver.  
Installation varies depending on the method of connecting to the printers. 

For Windows Vista 

Serial / Parallel Port 

1. Click [Add a printer] in the printer folder, the host will display the [Add Printer]. 
2. Select [Add a local printer]. 
3. Click [Use an existing port], select the printer port and then click [Next]. 
4. Select the best match for hardware and then click [Next]. 
5. Type a name for this printer and then click [Next] and proceed with the installation. 

USB Port 

1. Turn on the printer and connect it to the USB port on the computer. 
2. When the printer is recognized, the host will display the [Found New Hardware Wizard]. 
3. Select [Locate and install driver software (recommended)]. 
4. Click [Continue] in the [User Account Control] window, and then select [Don't search online] in the [Found 

New Hardware Wizard]. 
5. Select [I don't have the disc. Show me other options.]. 
6. Select [Browse my computer for driver software (advanced)]. 
7. Search for printer driver and then click [Next]. 
8. Select the best match for hardware and then click [Next] and proceed with the installation. 
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For Windows XP 

Serial / Parallel Port 

1. Click [Add a printer] in [Printer Tasks] to the left of the printer folder window. 
2. Click [Next>] in [Add Printer Wizard]. 
3. Select [Local printer attached to this computer] and then click [Next>]. 
4. Click [Use the following port], select the printer port and then click [Next>]. 
5. Select the best match for hardware and then click [Next>]. 
6. Type a name for this printer and then click [Next>]. 
7. Click [No] in [Print test page] and then click [Next>]. 
8. Confirm printer setting and then click [Finish] and proceed with the installation. 

USB Port 

1. Turn on the printer and connect it to the USB port on the computer. 
2. When the printer is recognized, the host will display the [Found New Hardware Wizard]. 
3. Select [No, not this time] and then click [Next>]. 
4. Select [Install from a list or specific location (Advanced)] and then click [Next>]. 
5. Select [Search for the best driver in these locations] the best driver found will be installed and then click 

[Next>]. 
6. Select the best match for hardware and then click [Next>] and proceed with the installation. 
 



 

2.4 Notes 
• For serial communications, match the printer's serial port settings with the host settings. Please 

refer to “Chapter 4 Setting Properties” or instructions on how to configure those settings. 

• For serial communications, selecting [Yes] to [Do you want to print a test page?] during the 
installation wizard may result in garbled output if there are any differences in the communications 
settings between the computer and printer. 

• When the printer is connected to a different USB port on the computer, the host will recognize it as 
another printer, and again require for printer driver installation. When reconnecting the USB cable 
after installation, reconnect it to the same USB port that was connected during installation. 

• For second or subsequent installations, you may be asked where the printer driver files are located 
again. Specify the location of the printer driver files again. 

• The [Windows Security] or [Windows Logo Test] warning may be displayed during installation, but 
proceed with the installation. 

 

 

 

 

 

 

Warning dialog in Windows Vista     Warning dialog in Windows XP 
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Chapter  3  PChapter 3 Printing  Preferences  rinting Preferences

3.1 Overview 
Settings for paper and printing control can be set from the [Printing Preferences] window. 

3.2 Printing Preferences Window 
To display the [Printing Preferences] window, follow the steps below. 

1. Right-click a printer icon in the printer folder to display the sub-menu. 
2. Click [Printing Preferences…] from a displayed sub-menu. 

3.3 Advanced Options 
Detailed printing preferences can be changed from the [Advanced Options] window. 
To display the [Advanced Options] window, follow the steps below. 

1. Display [3.2 Printing Preferences Window] -mentioned [Printing Preferences] window.  
2. Click [Advanced…] in the lower right of the [Printing Preferences] window to display the [Advanced 

Options] window.  

3.3.1 Paper Size 

Select the paper size to use for printing. 
New paper sizes can be added from the [Print Server Properties]. 
For more details, refer to “5.4 How to Add New Paper Size”. 

3.3.2 Print Mode 

Select the print processing mode (Page mode Priority and Standard mode). 
• Page Mode Priority  : A paper size that can print with the page mode is printed with the page mode. In 

other cases, printed with standard mode. 

• Standard Mode  :Print operation is conducted only in Standard mode. 

* For the CPU-type model, Standard mode is always used. Item of the print mode is not displayed. 

3.3.3 Print Density 

Select the print density level. 



 

3.3.4 Form Discharge 

Select the paper discharge operation after printing. 

• Enable   : Paper is discharged to for length of selected paper. 

• Disable   : Paper is not discharged after printing regardless of the selected paper length. 

* When using marked paper, be sure to select [Disable]. 

3.3.5 Cutter Control 

• Full Cut    : Enables paper full cutting. 

• Partial Cut   : Enables paper partial cutting. 

• Non Cut    : Disables paper cutting. 

3.3.6 Function Settings 

Function settings stored in printer memory can be displayed or changed. 

Please operate this function in the condition that the printer is ready for printing. 

For more details about function settings, refer to P
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Prriinntteerr  TTeecchhnniiccaall  RReeffeerreennccee. 

Concrete instructions for changing the function settings are as follows: 

1. Click [Function Settings] => [Setup…] to display the current function settings. 
2. Double-clicking the displayed item enters the edit mode. 
3. After completing the setting change, click [Apply] to write the settings to the printer. 
4. If you want to save the current settings on the list to a file, click . 
5. If you want to restore the saved data from the file in which the settings were saved, click . 
6. If you want to exit, click the  button. 
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Chapter  4  SChapter 4 Setting  Properties  etting Properties

4.1 Overview 
Printer driver settings can be set from the [Properties] window. 

4.2 Properties Window 
To display the [Properties] window, follow the steps below. 
1. Right-click a printer icon in the printer folder to display the sub-menu. 
2. Click [Properties] from a displayed the sub-menu. 

4.3 Notes 
The following explains of each seat of the printer driver setting-related notes. 

4.3.1 Ports Tab 

• Select the [Enable bidirectional support] check box. 

• When using the serial port, clicking [Configure Port] will display the COM Properties window.  
Configure the settings in accordance with the printer's communication settings. 

4.3.2 Security Tab 

• Users denied access privileges in [Print] disables the printing function. 

• Users denied access privileges in [Manage Printers] cannot use some functions using bidirectional 
communication. 
But, this tab is not displayed by default in Windows XP standard display setting. 
Only for Professional Edition in Windows XP, the following operation can change to displayed setting. 
[Printers and Faxes] => [Tools] => [Folder Options…] => [View] => [Use simple file sharing 
(Recommended)] exclude a check. 
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Chapter  5  PChapter 5 Page  Setup  age Setup

5.1 Overview 
The following explains the paper supported by the printer driver. 

There are two types of usable paper sizes: the default size automatically installed (hereinafter referred to as 
“Factory default”) and sizes that users can add (hereinafter referred to as “User defined”). 

To add user defined, refer to “5.4 How to Add New Paper Size”. 

5.2 Driver Models and Paper Sizes 

Usable paper sizes vary depending on each Driver Model.  
About usable paper sizes in each Driver Model, refer to “Appendix B Paper” – “(1) Paper Sizes”. 

5.3 Margin Sizes 

The print margin is set for the paper when printing. Margin sizes may be different between the computer 
screen and the paper. For details about the print margin, refer to “Appendix B Paper” – “(2) Margin Sizes”. 

A larger paper width than the actual paper size available for the printer such as “A4” and “Letter” can be 
selected, but large margins are shown to the right and left on the computer (screen). 

 



 

5.4 How to Add New Paper Size 
The following explains the procedure for adding a new paper size. 

① Click [Server Properties] from the [File] menu of the printer folder. 
② Display the [Forms] tab in the [Print Server Properties] window. 
③ Click the [Create a new form] check box. 
④ Specifies the new paper size name in the [Form name] field over the factory default paper size name. 
⑤ Click the [Metric] radio button. 
⑥ Specifies the width for the new paper size in the [Width] field of the [Form description (measurements)]. 
⑦ Specifies the length for the new paper size in the [Height] field of the [Form description (measurements)]. 
⑧ Finally, click [Save Form] to complete the procedure for adding a new paper size. 

 

③Click here. 

④Specifies new paper size name.

⑥Specifies paper width. 

⑧Button to save form. 

⑤Click here. 

⑦Specifies paper length. 

 

5.5 Notes 
• The printable area is different from the paper size. 
• If the paper size is set with margins of “0” the fixed margin size is used. 
• Be sure to use [Metric] for [Units] in the [Form description (measurements)]. 

• Of the paper sizes listed in the [Forms] tab, those that correspond to the sizes specified in the “Appendix B 
Paper” – “(1) Paper Sizes” will be available for the printer driver. 
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Chapter  6  CChapter 6 Communications  Library  ommunications Library

6.1 Overview 
The printer driver has a dynamic link library (hereinafter referred to as "DLL") for developers to control the 
printer directly. 

6.1.1 Functions 

DLL provides the following functions for application software to be developed. 

• Transmitting data to the printer 
• Receiving data from the printer 
• Executing a printer reset 
 
DLL is installed together with the printer driver and functions with the driver. 
DLL can control the printer directly and makes the software development independent of the port type 
possible. 

6.1.2 Library File 

DLL file name is as follows: 

SII_CAPD_API.DLL 

6.1.3 File Storage Location 

The DLL file is installed in the system folder of Windows.  
Except in special circumstances, you do not have to set the path to the folder where the DLL file is stored. 

[DLL Installed folder] 
%WINDIR%¥System32 
%WINDIR% means a Windows folder (e.g., c:¥Windows). 
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6.2 Functions 

6.2.1 List of DLL Functions 

The following explains the functions of the DLL files. 
For more details, refer to the attached sample program. 

Function Name Function Overview 

OpenSiiPrinterA 
OpenSiiPrinterW 

Create a printer object and retrieve ID 

CloseSiiPrinter Close the printer object and disable ID 

GetSiiPrinterAutoStatus Retrieve AAuuttoo  SSttaattuuss  RReessppoonnssee 

SetSiiPrinterCallbackStatus Set the callback function that will be called by change of AAuuttoo  
SSttaattuuss  RReessppoonnssee 

SetSiiPrinterData Send data to the printer 

GetSiiPrinterDataA 
GetSiiPrinterDataW 

Retrieve response data from the printer 

SetSiiPrinterReset Hardware reset the printer 

 

•  About the function name which have the parameter of string style. 
A suffix of “W” or “A” for some function names means that the function name needed to be called varies 

depending on whether to use MBCS (multi-byte code) or Unicode as an parameter to be set with strings.  
For example, to call OpenSiiPrinter, use OpenSiiPrinterA for MBCS and OpenSiiPrinterW for Unicode. 
 
Please note that a suffix of “W” or “A” is omitted in the following function explanations. 
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6.2.2 Details of DLL Functions 

The following is detailed specification of each function. 

Common Specifications of All Functions 

Return value 

Returns an error code (≠ 0) for any failure of the function and Zero (= 0) in case of success. 

Remarks 

For the error code, refer to “6.4 Return Values (Error Codes)”. 



 

14/26 

Rev 2 

 

OpenSiiPrinter 

Creates a printer object and retrieves ID. 

DWORD OpenSiiPrinter ( 
LPCTSTR pszName , 
LPDWORD pdwSessionId) 

Parameters 

 pszName 
Pointer to a null terminated string that specifies the name of the printer. 

 pdwSessionId 
 Pointer to a variable that receives ID to the specified. 

Remarks 

If the ID obtained from this function is not in use, close ID by calling the CloseSiiPrinter function. 

The function will succeed regardless of the connection state between the printer and the computer. 

If the connection destination of the printer driver is an unsupported port, the function will fail. 

 

CloseSiiPrinter 

Closes the printer object and disables ID. 

DWORD CloseSiiPrinter ( 
DWORD dwSessionId) 

Parameters 

dwSessionId 
ID retrieved with the OpenSiiPrinter function. 

Remarks 
ID of the printer object is disabled. 

AAuuttoo  SSttaattuuss  RReessppoonnssee monitoring with the SetSiiPrinterCallbackStatus function is stopped. 
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GetSiiPrinterAutoStatus 

Retrieves a current AAuuttoo  SSttaattuuss  RReessppoonnssee. 

DWORD GetSiiPrinterAutoStatus ( 
DWORD dwSessionId, 
LPDWORD pdwStatus) 

Parameters 

dwSessionId 
ID retrieved with the OpenSiiPrinter function. 

pdwStatus 
Pointer to a variable to receives AAuuttoo  SSttaattuuss  RReessppoonnssee. 

Remarks 

This function retrieves current AAuuttoo  SSttaattuuss  RReessppoonnssee. 

Detecting disconnection with printer retrieves 0 as the current AAuuttoo  SSttaattuuss  RReessppoonnssee. 

For more details about the data of AAuuttoo  SSttaattuuss  RReessppoonnssee that can be retrieved, refer to “6.3 Printer 
Status Data”. 
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SetSiiPrinterCallbackStatus 

Sets the callback function that is called by change in AAuuttoo  SSttaattuuss  RReessppoonnssee. 

DWORD SetSiiPrinterCallbackStatus ( 
DWORD dwSessionId, 
INT （CALLBACK EXPORT＊lpfnCallBackStatus）(LPDWORD pdwStatus )) 

Parameters 

dwSessionId 
ID retrieved with the OpenSiiPrinter function. 

lpfnCallBackStatus 
Function pointer of the callback function. 

pdwStatus 
Pointer to a variable to receive AAuuttoo  SSttaattuuss  RReessppoonnssee with the callback function. 

Remarks 

If there is a change of AAuuttoo  SSttaattuuss  RReessppoonnssee then the registered callback function is called. 

This function is stop calling with callback by calling the CloseSiiPrinter function or 
GetSiiPrinterAutoStatus function. 

At first, the callback-function registered by this function will be only once called with the current AAuuttoo  
SSttaattuuss  RReessppoonnssee. 

For more details about AAuuttoo  SSttaattuuss  RReessppoonnssee returned by this function, refer to “6.3 Printer Status 
Data”.  

Even when receiving AAuuttoo  SSttaattuuss  RReessppoonnssee from the printer if no difference with AAuuttoo  SSttaattuuss  
RReessppoonnssee is found then callback function is not called. 

If there is a change of connection state with the printer then the callback function is called. 

The detection of disconnection returns 0 as the current AAuuttoo  SSttaattuuss  RReessppoonnssee. And the detection of 
re-connection returns the actual  AAuuttoo  SSttaattuuss  RReessppoonnssee. 

Synchronization between AAuuttoo  SSttaattuuss  RReessppoonnssee change and function call timing is not assured. 

If calling this function again in a state where the callback function has already been registered using this 
function, previously registered function information will be disabled. If specifying null to 
lpfnCallBackStatus, AAuuttoo  SSttaattuuss  RReessppoonnssee monitoring will be interrupted. 

The return value of the callback function is ignored. 
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SetSiiPrinterData 

Writes data to the printer. 

DWORD SetSiiPrinterData ( 
DWORD dwSessionId, 
LPBYTE pCmd, 
DWORD cbCmd, 
LPDWORD pcWritten) 

Parameters 

dwSessionId 
ID retrieved with the OpenSiiPrinter function. 

pCmd 
Pointer to an array that stores printer data. 

cbCmd 
Specifies the array size in bytes. 

pcWritten 
Pointer to a value that receives the number of bytes of data that were written to the printer. If it is not 
necessary, null can be specified. 

Remarks 

The control of the function is not returned until the end of transmission or timeout. 

The timeout for all ports is set to a time which is specified as timeout of the system (LPT port). 
Timeout of a system (LPT port) is set by the following. 

1. Select the printer port (LPTx) from the port sheet in the property dialog explained in  
"Chapter 4 Setting Properties". 

2. A value of timeout is shown by clicking [Configure port...] button, and input new value of timeout.  
 
or 
 

1. A value of timeout is able to change by editing a value of “TransmissionRetryTimeout” existing 
in the HKEY_LOCAL_MACHINE folder on registry by using registry editor (regedit.exe). 

Be careful that target port is not changed by this operation. 

The value of timeout can not be set less than 5 second. 

The measuring of timeout becomes effective from the stopped state of data transmission.  

Actual timeout may be longer than specified time. 

To validate setting must restart your computer. 

If a command to disable AAuuttoo  SSttaattuuss  RReessppoonnssee is included in data to be output, the subsequent AAuuttoo  
SSttaattuuss  RReessppoonnssee may not be retrieved properly. 

When the data is sent by multiple times, the command for AAuuttoo  SSttaattuuss  RReessppoonnssee may interrupt in 
between each data blocks. In particular, when it outputs data (ex. image data) that the interrupt of other 
data is not forgiven on the way, please output all data by one time. 
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If the data size written to the printer is not same to the sizes specified by cbCmd, then this function will 
work as the following. 

 If pcWritten set null, this function returns an error code.  
 In other cases, the data size written is set in the variable specified by pcWritten, and this function 

returns a success code. 
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GetSiiPrinterData 

Retrieves response data from the printer. 

DWORD GetSiiPrinterData ( 
DWORD dwSessionId, 
LPTSTR pValueName, 
LPBYTE pData, 
DWORD cbData, 
LPDWORD pcbNeeded) 

Parameters 

dwSessionId 
ID retrieved with the OpenSiiPrinter function. 

pValueName 
Response command string that identifies data to be retrieved.     

pData 
Pointer to a variable that stores response data. 

cbData 
Number of data bytes that indicates the array size.                     

pcbNeeded 
Pointer to a variable that receives a necessary buffer size or the number of actually received bytes. 

Remarks 

This function retrieves a command response data from the printer by specifying to pValueName a 
command string listed in “Appendix C Response Command String”.  For command response, refer to 
PPrriinntteerr  TTeecchhnniiccaall  RReeffeerreennccee.  

If you want to retrieve the response data size, calling the function while setting “0” to cbData stores the 
size to a variable specified by pcbNeeded. If there is no data to be returned, zero is stored.   

Specifying “GET_RAW_DATA_AUTO_STATUS” to pValueName retrieves the history of AAuuttoo  SSttaattuuss  
RReessppoonnssee. If the retrieved AAuuttoo  SSttaattuuss  RReessppoonnssee is same as last AAuuttoo  SSttaattuuss  RReessppoonnssee then it will be 
ignored. And if disconnection is detected, AAuuttoo  SSttaattuuss  RReessppoonnssee is retrieved as all zero. 

Specifying “GET_RAW_DATA_EXEC_RESP” to pValueName retrieves the history of execution command 
response (hereinafter called “Execution Response”) that was output by SetSiiPrinterData function.  

Specifying “GET_RAW_DATA_CMD_RESP” to pValueName retrieves the history of general command 
response that was output by SetSiiPrinterData function excluding AAuuttoo  SSttaattuuss  RReessppoonnssee and 
Execution Response.  

Each history data is recorded since the calling of OpenSiiPrinter function and held until up to 256 bytes. 

Command strings listed in “Appendix C Response Command String” cannot be used for the 
GetPrinterData function, which is Win32API function. 

If the function fails (the return value is not “0”), contents of all parameters are undefined. 

The function fails by setting command to pValueName. 
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SetSiiPrinterReset 

Hardware resets the printer. 

DWORD SetSiiPrinterReset ( 
DWORD dwSessionId) 

Parameters 

dwSessionId 
ID retrieved with the OpenSiiPrinter function. 

Remarks 

A success of hardware-reset generates a waiting time of about 500 ms. 

This hardware resets using communication lines (without using commands). 

Reset using communication lines needs to be enabled in printer function settings.  
For more details about printer function settings, refer to PPrriinntteerr  TTeecchhnniiccaall  RReeffeerreennccee. 
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6.3 Printer Status Data 

The following indicates the contents of the data of AAuuttoo  SSttaattuuss  RReessppoonnssee that is retrieved by the DLL 
functions. 

6.3.1 Overview 

• Auto  Status  Response can also be retrieved with the GetSiiPrinterAutoStatus function, 
SetSiiPrinterCallbackStatus function and GetSiiPrinterData function. 
For more details, refer to each function’s section. 

Auto Status Response

• Auto  Status  Response is stored to the variable specified by pdwStatus which is the parameter of the 
above function. 
Auto Status Response

• The content of Auto  Status  Response is included up to the identifier bits stored from lowest byte (0-7 
bit) of variable. 

Auto Status Response

• If the printer is disconnected, then Auto  Status  Response is expressed as all bits including identifier are 
0.  

Auto Status Response

6.3.2 Notes 

• Outputting a command that disables a response feature of Auto  Status  Response with the 
SetSiiPrinterData function may result in failure to return Auto  Status  Response properly. 

Auto Status Response
Auto Status Response

• When the flow control of the serial connection is set to hardware, operation with the DSR terminal fixed to 
the Mark side is not supported. 

• Communication failure with the printer or communication error occurrence may also result in the 
“disconnect state”. 

• If the DSR terminal and DTR terminal work together in the case of serial connection, cable disconnection is 
detected as the “disconnect state” but printer power-off is not. 

• Even when the flow control of the serial connection is set to software, connect using a dedicated cable or a 
cable supporting 9-pin terminals introduced in [Serial Interface Connector Pin Assignment] of Printer  
Technical  Reference. Otherwise some of the functions may not operate properly because a serial cable 
cannot detect the connection state unless at least it TXD, RXD, DTR, and DSR terminals are connected to 
the host and the printer. 

Printer
Technical Reference

• For more details about [Automatic Status Response] printer command, refer to Printer  Technical  
Reference. 

Printer Technical
Reference
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6.4 Return Values (Error Codes) 
If the function succeeds, the return value is Zero (ERROR_SUCCESS). If the function fails, the return value is 
an error code. The error code is based on the Windows system error code. 

For Windows error codes, refer to Microsoft documents (such as SDK System Error Codes). 

The error content may be vague or unclear because of using the common codes (Windows error codes). To 
complement this, the following indicates error names (error codes) and probable causes. 

Principal Windows System Error Codes and Probable Causes 

Error Name (Error Code) Probable Causes 

ERROR_ACCESS_DENIED（5） 
[Deny] is selected in [Print] or [Manage Printers] on the 
Security tab. 

ERROR_BAD_ENVIRONMENT(10) The DLL version does not match the printer driver. 

ERROR_SHARING_VIOLATION(32) A printer driver module for another model is operating the 
port. 

ERROR_BUSY(170) The printer is busy. 

ERROR_DEVICE_NOT_CONNECTED(1167) 
 The printer is disconnected. 
 The printer is powered off. 

ERROR_UNKNOWN_PORT(1796) An unknown port is specified. 

ERROR_UNKNOWN_PRINTER_DRIVER(1797) An unknown printer driver is specified. 

ERROR_INVALID_PRINTER_STATE(1906) 
 The printer driver is in offline state. 
 Bidirectional support is invalid. 

ERROR_DEVICE_NOT_AVAILABLE(4319) 
 The printer is in busy state. 
 Communication is impossible. 

 
 



 

6.5 Sample Program 

6.5.1 Overview 

The sample program as a reference when using DLL for application (Visual C++ version 6.0) is attached. 

6.5.2 Notes 

• SII does not warrant that the sample program is error free nor does SII provide technical support for the 
program. 

• The sample program may be changed without notice. 

6.6 Notes 
• The circuit assumes that SII products/interface boards are used or the recommended circuit state is kept. 

Usage for other circuits is not supported. 

• All DLL functions are only available for local connection. Network connection via shared printers is not 
supported. 

• When resetting the printer using DLL functions or reset command output, take enough time for the next data 
output process so that the printer reset is completed. Data output during the reset process may cause data 
errors. 

• If sending the command data which are for the hardware-reset or the invalidation of Auto  Status  
Response by the SetSiiPrinterData function, then the functions for Auto  Status  Response may be 
invalided 

Auto Status
Response Auto Status Response

• Using DLL is only available when the bidirectional support is enabled. 
To confirm the validity of the bidirectional support, check whether [Enable bidirectional support] is selected 
at the bottom of the [Ports] tab as explained in “Chapter 4 Setting Properties”. 

[Setting Properties] – Bottom of the [Ports] tab 
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Chapter  7  OChapter 7 Other  Notes  ther Notes

• Due to the printer mechanism, the actual length of Form Discharge from the printer may be slightly 
different from the specified Paper Size. 

• Printing functions using network connection via shared printers are also supported. 
However, the features of bidirectional communication (DLL) are only supported for locally connected 
printers.  

• Test print by clicking [Print Test Page] on the [General] tab of the [Properties] window explained in 
“Chapter 4Setting Properties” will not properly image a printout on paper for compact printers, but it does 
not indicate a defect. 

• The printer driver does not support printing with the fonts on the printer. 

• Printer information retrieved by Windows features, such as the status member of PRINTER_INFO_X 
structure defined by the Windows Platform SDK, is not supported. 

• Do not install other printer drivers to the same port. 

• In case of serial connection, match the printer's serial port settings with the host settings.  
About the change method, clicking and setting the [Configure Port] after selecting the "COMx : Serial 
Port" on the [Port] tab of the [Properties] window explained in “Chapter 4 Setting Properties”. 

• In case of serial connection, the communication speed of 115200 bps is recommended. Other speed 
settings may cause unstable print speed and the decline of the quality. As other communication settings, 
set the bit length to “8 bits” and the flow control to “hardware”. 

. 
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Chapter  8  DChapter 8 Disclaimer  isclaimer

SII has carefully designed this software to ensure that it is trouble-free. However, SII is not liable for any 
damage or loss caused by or related to the use of this software. 
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Chapter  9  RChapter 9 Revision  History  evision History

Rev 0  Apr 2008 
 First Edition. 

Rev 1  Jun 2008 
 Added a remark to [SetSiiPrinterData] in the [6.2.2 Details of DLL Functions]. 

Rev 2  Sep 2008 
 Added a remark to [SetSiiPrinterData] in the [6.2.2 Details of DLL Functions]. 
 Changed the margin size when using paper cutting. 
 Modified some formats. 

 
 
 



Appendix A Driver Model 
    

Driver models supporting the product (interface or CPU) are listed below. 

Select a printer driver according to applications as installation. 

 

List of Driver Models 

Product Name Usable Mechanism Model Supported Driver Model 

LTPD245 

CAPD245 
SII IFD50x (2inch)  IFD501-01SK-E 

IFD501-01UK-E 
 (Interface) LTPD345 

CAPD345 
SII IFD50x (3inch) 

LTPD245 

CAPD245 
SII PTD50 (2inch) 

PTD50P01-E 
(CPU) LTPD345 

CAPD345 
SII PTD50 (3inch) 

LTPD247 

CAPD247 
SII IFD00x (2inch) IFD001-01SK-E 

IFD001-01UK-E 
(Interface) LTPD347 

CAPD347 
SII IFD00x (3inch) 

LTPD247 

CAPD247 
SII PTD00 (2inch) 

PTD00P01-E 
(CPU) LTPD347 

CAPD347 
SII PTD00 (3inch) 

 

• The CPU type always runs in standard mode for printing. (Items selected in [Advanced 

Options] are not displayed.） 

• Specifications other than above are common regardless of driver models. 

 



Appendix B Paper 
    

(1) Paper Sizes 

Usable paper sizes in each driver model are as follows: 

List of Paper Sizes 

Driver Model Factory Default or User 
Defined Sizes (Limits) 

Factory Default 
A4 

Letter 
58×297 mm 

Width 58 mm 

SII IFD50x (2inch) 
SII PTD50 (2inch) 
SII IFD00x (2inch) 
SII PTD00 (2inch) User Defined 

Length 30–3276 mm 

Factory Default 
A4  

Letter  
80×297 mm 

Width 80 mm 

SII IFD00x (3inch) 
SII IFD50x (3inch) 
SII PTD00 (3inch) 
SII PTD50 (3inch) 

User Defined 
Length 30–3276 mm 

 

• If selecting a larger paper width than the actual paper size available for printers such as [A4] 
and [Letter], large margins are shown to the right of the paper on the computer (screen). 

• The paper length for using mark paper has to be the following. 
   # The paper length < [Distance between each marks] - [Top Margin Length] - 10mm 

• For using the mark paper, the length of the paper or print is very short in comparison with the 
distance between each marks, it may need to change the setting of [Mark range] on Function 
Settings. 



(2) Margin Sizes 

Print margin sizes on the computer or the printer are as follows: 

 

List of Margin Sizes (unit: mm) 

Margin Size 
Driver Model  Margin Position 

Computer Side Printer Side 

With Cut 12.5 mm ← 
Top Margin

No Cut 0 mm ← 

With Cut 0.5 mm ← Bottom 
Margin No Cut 0 mm ← 

SII IFD50x (2inch) 
SII PTD50 (2inch) 

Right/Left Margins Total 
Paper Width – 

48 mm 
10 mm 

With Cut 12.5 mm ← 
Top Margin

No Cut 0 mm ← 

With Cut 0.5 mm ← Bottom 
Margin No Cut 0 mm ← 

SII IFD00x (2inch) 
SII PTD00 (2inch) 

Right/Left Margins Total 
Paper Width – 

54 mm 
4 mm 

With Cut 12.5 mm ← 
Top Margin

No Cut 0 mm ← 

With Cut 0.5 mm ← Bottom 
Margin No Cut 0 mm ← 

SII IFD00x (3inch) 
SII IFD50x (3inch) 
SII PTD00 (3inch) 
SII PTD50 (3inch) 

Right/Left Margins Total 
Paper Width – 

 72 mm 
8 mm 

• Top margin sizes vary whether paper is cut or not. 

• If the paper size on the computer and the actual size are different, the margin size on the 
computer is also different from the actual margin size to be output. 

• [Computer Side] in [Margin Size] means a margin size for selected paper recognized on the 
computer. 

• [Printer Side] in [Margin Size] means a margin size for paper actually output from the printer. 

• When using [Marked Paper], the top and bottom margin sizes on the printer are different from 
the above value. (It depends on the printer’s paper feed volume setting.) 



Appendix C Response Command String 
    

Command strings (pValueName) specified as the second parameter of GetSiiPrinterData 
function in DLL are listed below. 

For [Printer Command] names, refer to the PPrriinntteerr  TTeecchhnniiccaall  RReeffeerreennccee. 

 
List of Command Strings 

Supported Command String (pValueName) Printer Command 

GET_RAW_DATA_AUTO_STATUS History data for AAuuttoo  SSttaattuuss  RReessppoonnssee 

GET_RAW_DATA_EXEC_RESP History data for Execution Response 

GET_RAW_DATA_CMD_RESP History data excluding AAuuttoo  SSttaattuuss  RReessppoonnssee and 
Execution Response 

AUTO_STATUS_BACK AAuuttoo  SSttaattuuss  RReessppoonnssee 

FUNCTION_SET_RESP Function Setting Response 

REMAIN_NV_MEMORY_CAP Remaining User Area Response 

STATUS_DATA_SEND_PAPER Status Response [Send Status Data of Paper 
Sensor] 

STATUS_DATA_SEND_PRESENTER Status Response [Send Other Status Data] 
PRINTER_ID_SEND_DEV Printer ID Send [Printer Model ID] 
PRINTER_ID_SEND_TYPE Printer ID Send [Type ID] 

PRINTER_ID_SEND_ROM Printer ID Send [ROM Version ID] 

ERROR_HISTORY_RESP Error History Response (n=0x80) 

 



Appendix D Condition of Function Settings  
  

For using the printer driver, the some items of the function setting stored in the memory of 
the printer needs to be the following settings. 

The function setting can be also changed by printer driver to the settings that are 
unsupported condition by the printer driver. But the unsupported settings may cause a state 
that the printer driver does not work. 

 

Item Name Setting Condition 

SWDIP5 – 2  
(Print data handling when an error occurs) 1：Disable 
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